MODULE 5 WORD
05 Indents + Tabs

O5 Indents + Tabs

Introduction

Indenting text adds structure to your document by allowing you to
separate information. Whether you'd like to move a single line or an
entire paragraph, you can use the tab selector and the horizontal ruler
to set tabs and indents.

Play the video by clicking the link below:
Indents + Tabs

Exercise 05a
Using the sample as a guide, follow the directions below to complete the exercise.

[ ] Open a file on your computer:
Word 05a Template INDENTS + TABS

[] Save the file in your Documents Folder:
File > Save As > Documents

[] Name your file by typing in the File Name box:
Word 05a YourFirstNamelLastlnitial INDENTS + TABS
Save as type: Word Document

[] Before starting this exercise, check to see if your rulers are showing.
Click on the View Tab. Check the box to show the Ruler.
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http://www.gcflearnfree.org/word2013/indents-and-tabs/1/
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The Ruler is located at the top and to the left of your document. It makes it
easier to adjust your document with precision. Your ruler should always be
active when working in word documents.

Read the following information to get familiar with the Indent Marker tools:

Indenting Text:

In many types of documents, you may wish to indent only the first line of
each paragraph. This helps to visually separate paragraphs from one another.
It’s also possible to indent every line except for the first line, which is known
as a hanging indent.

L 1---|---E---|---1---|---1---|---J---|---4---|--

Indent Markers:
Word provides indent markers that allow you to indent paragraphs to the
location you desire. For the indent markers to work, text must be selected.

The indent markers are located to the left of the horizontal ruler, and they
provide several indenting options:

First-line indent marker *': Adjusts the first-line indent.

Hanging indent marker;™ : Adjusts the hanging indent.

Left indent marker [1: Moves both the first line indent and hanging indent
markers at the same time (this will indent all lines in a paragraph)

May 30, 2014
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[] Select the lines of text January 12, 2016 all the way down to Dear Mr. Joyner

January 12, 2016

415 Bishop Street
Saskatoon, SK S7L 1X1

Mr. Nathaniel Joyner, CEO
Vesta Insurance Group
2155 Airport Drive
Saskatoon, SK 60601

Dear Mr. Joyner:

Thank you so much for the time that you took yesterday to inten
Administrative Assistant position. It was great to meet you and le
administrative needs at Vesta Insurance. On my tour of your buil
important it is that your Administrative Assistant not only be the
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[] Click your mouse on the bottom rectangle part of the Indent Marker then
hold and drag the Indent marker to the left.

Move the Indent Marker to line up the text with the paragraphs on the left
side of the page. A live preview of the moving text will appear in the document.

P Paragraph

[ ] Release the mouse.
The paragraphs will line up with the text on the left side of the page.

January 12, 2016

415 Bishop Street
Saskatoon, SK S7L 1X1

Mr. Nathaniel Joyner, CEO
Vesta Insurance Group
2155 Airport Drive
Saskatoon, SK 60601

Dear Mr. Joyner:

Thank you so much for the time that you t
Administrative Assistant position. It was gr
administrative needs at Vesta Insurance. O
important it is that your Administrative As:
of the company, but also an integrated me
when issues arise. ] completely agree with
skills will be an asset to your company.

[] Select the text Sincerely down to addie.patel@gmail.com
make me an excellent candidate for Vesta Insurance Group's team.

Please feel free to call or email me if you have any further questions. [ lock forward to
speaking with you, again.

Sincerely,

Adrienne Patel

306-555-6840
addie.patel@gmail.com
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This time, you will Indent using the Indent Commands:
The indent commands Increase or Decrease the indent by increments
of % inch.

Click on the Decrease Indent command until the text lines up with the
paragraphs on the left side of the page.

INSERT Developer DESIGM PAGE LAYOUT REFERENCES MAILINGS
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Please feel free to call or email me if you have any further questions.
speaking with you, again.

Sincerely,

Adrienne Patel

306-555-6840
addie.patel@gmail.com

The text is line up on the left side of the page.

someone specifically with website maintenance experience. I was also very impressed with
how well maintained and thorough your company’s client database is. As you upgrade to
your new database system, [ believe my experience troubleshooting database issues will
make me an excellent candidate for Vesta Insurance Group's team.

Please feel free to call or email me if you have any further questions. I look forward to
speaking with you, again.

Sincerely,

Adrienne Patel

306-555-6840
addie.patel@gmail.com
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You can also customize indent amounts by entering desired values in the

boxes under indent.

[ ] Place your cursor in front of the date: January 12, 2016
Click the Page Layout Tab. Enter 5.25 in the Indent Left box. Press Enter.

INSERT Developer DESIGM PAGE LAYOUT
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415 Bishop Street
Saskatoon, SK S7L 1X1

1 Scroll down to Page 2 of the document

January 12, 2016

Use the indent marker to make the following changes to the resume.
You may use any of the three ways you practiced on page 1

MODULE 5 WORD
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[] Select the entire SUMMARY and SKILLS section and line it up with the

word ADRIENNE located in the large font at the top of the page.

SUMMARY EXPERIH
Techjsavvy, solutions- Executive
oriented professional with Rev Devel
expelience in all aspects of Supporte;
officd management, Develope|
i and support. delivered
website, §
skilks and per d
Winc ows & Mac Office Ms
Micrgsoft Office Carter Ta)
il et Managed
iy [Fafd Pioneereq
o= e tracking b
jCns el schedules
Lotug Notes
il ST AR Administ)
Adobe Photoshop lcon Offic!
Supporte|
Service

I I X ="

ADRIENNE |
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[] Select the entire EXPERIENCE section and line it up with 415 Bishop Street

in the address line.

| T A W

ADDRESS

ADRIENN

?l---.---l---.---

415 Bishop Street #303
Saskatoon, SK 571 1X1

CELL 306.555.6840
EMAIL addie.patel@gmail.com

F PATEL

SUMMARY
Tech-sawwy, solutions-
oriented professional
with experience in all
aspects of office
management,
administration, and
support.

SKILLS

Windows & Mac
Microsoft Office
Apple Work
SharePoint
Salesforce
QuickBooks

Lotus Notes
Adobe InDesign
Adobe Photoshop

[ ] Select the entire VOLUNTEER WORK section and line it up with the
SUMMARY and SKILLS Section.

Adobe Photoshop

Fll | Font T Faragraph 1Pl Styles P |
-.---1---&---2---.---3---.---4---.---5---.---5---_
ppie "‘_'°"c tracking business contacts and managing financial advisors’
harePoint schedules.
Salesforce
QuickBooks Administrative Assistant Regina, SK
Lotus Notes lean Office Solutions, May 1997 — Octaber 2007
Adobe InDesign Supported the Of i Manager, Branch M and two

Service Managers. Answered and directed incoming calls for
six phone lines. Processed monthly sales bills for an average
billing cycle of $350,000+.
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] Scroll down to Page 3 of the document

Next, you will move text by setting up Tabs

Using Tabs give you more control over the placement of text. Adding tab stops
to the ruler allows you to change the size of the tabs, and Word even allows
you to apply more than one tab stop to a single line.

First step in setting tabs is to select the paragraph or paragraphs you want to
add tab stops to. If you don’t select any paragraphs, the tab stops will apply to
the current paragraph and any new paragraphs you type below it.

L] Select the TRAINING & EDUCATION section.

Page Setup P Paragraph P Arrange
1---|---§---|---1---|---2---|---3---|---4---|---5---|---6---(_\]
TRAINING & EDUCATION

Microsoft Office Specialist MICROSOFT OFFICE2010
Microsoft Certification2008

Bachelor of Arts BUSINESS ADMIMNISTRATION
University of Hlinois Springfield1997 — 2001

Associate Degree OFFICE ADMIMISTRATION
Lincoln Land Community College1995 — 1997

The tab selector is located above the vertical ruler on the left. Hover the mouse over the
tab selector to see the name of the active tab stop.

[] Click the tab selector until the tab stop Right Tab appears.

Page Setup ] Paragraph T
ol 1---|---8---|---1---|---2---|---3---|---4---

TRAINING & EDUCATION

Microsoft Office Specialist MICROSOFT OFFICE2010

“ Microsoft Certification2008

Bachelor of Arts BUSINESS ADMIMISTRATION
University of Illinois Springfield1997 — 2001

~ Associate Degree OFFICE ADMINISTRATION
Lincoln Land Community College1995 — 1997
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[] Setthe location on the horizontal ruler where you want your text to appear

by clicking once on the bottom edge of the ruler at the 6 inch mark

TRAINING-&-EDUCATIONT

Microsoft-Office-Specialist- MICROSOFT-OFFICE- 20101
Microsoft-Certification-20081

T

Bachelor-of-Arts-BUSINESS- ADMINISTRATIONT
University-of-Regina-1997-—20011

|

Associate-Degree-OFFICE: ADMINISTRATIONT
Bethany-College-1995-— 19971

g"'l"'l"'I"'Z"'I"'}"'I"'4"'

5'5%&

Right Tab

[] Place the insertion point (cursor) in front of the date 2008 then press the
Tab key only ONCE. The text will move to the tab stop you set on the ruler.

TRAINING & EDUCATION

Microsoft Office Specialist MICROSOFT OFFICE 2010
Microsoft Certificatior’2008

Bachelor of Arts BUSINESS ADMINISTRATION
University of lllinois Springfield1997 — 2001

-g---|---1---|---2---|---3---|---

4 .

CACHERERIIEN FEAC N

Tab Stop

[] Place your cursor in front of 1997-2001 and press the tab key once.

[] Place your cursor in front of 1995- 1997 and press the tab key once.

All the dates will line up to the right side of the document.

TRAINING & EDUCATION

Microsoft Office Specialist MICROSOFT OFFICE 2010
Microsoft Certification

Bachelor of Arts BUSINESS ADMINISTRATION
University of Illinois Springfield

Associate Degree OFFICE ADMINISTRATION
Lincoln Land Community College

g"'l'"1"'I"'2"'I"'3"'I"'

2008

1997 - 2001

1995 - 1997
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[] Onthe Home Tab, click the Show Formatting symbols command.
Pressing this command shows you the type of formatting you have
in your document.

HOME INSERT DESIGM PAGE LAYOUT REFEREMCES MAILINGS REVIEW VIEW

SegoeUl  ~-[115 -| A A |Aa~ | & = -i=-5z2- | &3 | 2L | T || pabocde AsBb
B I U-asex, x| A-F-A-====|l=- H-H TNormal T No S
1 Font P Paragraph P Style

In the example below, each arrow represents one tab stop.
(one press of the tab key on the keyboard).

= =i = —e

'g"'I'"1"'I"':-|_"'I"']"'I'"4"'I"'5"'I"'§"'

TRAINING-&-EDUCATIONT

Microsoft-Office-Specialist-MICROSOFT-OFFICE-20101

Microsoft-Certification - Tab Key 20081
q Symbol
Bachelor-of-Arts-BUSINESS-ADMINISTRATIONT
University-of-Illinois-Springfield L~ 1997-—20011
T
Associate-Degree-OFFICE-ADMINISTRATIONT
Lincoln-Land-Community-College o 1995-—19971
L] Select the text in the AREAS OF SOFTWARE EXPERTISE section.
AREAS-OF-SOFTWARE-EXPERTISET
MS-Windows----=--=-sssemeeeees AVG-AntiVirus:---------- Adobe-Acrobat
MS wDrd ............................... MS. Ex,cel .............. M S. Pﬂwerpointﬂ
| e T e e Quickbooks:-------- Basics-PayrollT
QI1-Macros:-===-==r=rerememees Inventory-Mngmt------PowerPivotT

The series of dots between the columns are space bar spaces.
Each dot represents one space bar space.

We never want to use a series of space bar spaces to add large areas of space
between words or sentences. It can mess up your document and take a lot of
time to line things up.
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[] Click the tab selector until tab stop Left Tab appears.
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05 Indents + Tabs

L o

x

'E"""'1'"""2"""'3"""'4"""'5

AREAS-OF-SOFTWARE-EXPERTISET

] MS-Windows:---«--x=sssszeeeee AVG-AntiVirus-----:=----= Adobe-Acrobatf
- I N ] e e MS-Excel------------- MS-PowerpointT

) MS-Project:-==----:--=m=seeeeeneeee Quickbooks:--+---: Basics-PayrollT

N Q1-Macros------==----=----=-Inventory-Mngmt------PowerPivotT

[] Click on the bottom of edge of the ruler on the 2” measurement and click

again on 4” to set two tabs.

|_I Ellll%llgltl::?l L
s AREAS-OF-SOFTWARE-EXPERTISET
: MS-Windows-------=-=s=sseneeee AVG-AntiVirus:---------=--- Adobe-AcrobatT
- R e e |l S | e MS-PowerpointT
) B o e Quickbooks:-------- Basics-PayrollT
N Q1-Macros-+---++-====-------Inventory-Mngmt------PowerPivotl
[] Select the space bar spaces between MS Windows and AVG AntiVirus.
nglllllllt 1
; AREAS-OF-SOFTWARE-EXPERTISET
MS-Windows:=-----:------------ AVG-AntiVirus--------------Adobe- Acrobatf
. MsprnjectQu|ckbooksBas|csPayro“ﬂ
N QlMacms]nventoangthDwerP|UDtﬂ

[] Press the tab key on your keyboard once.

The spacebar spaces will be replaced with one tab.
AVG AntiVirus will line up with the first tab stop on the ruler.
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[] Continue selecting the groups of spacebar spaces between the columns and
replace each group with one press of the tab key.
The text will line up as follows:

glll{l]l‘LIEI

AREAS-OF-SOFTWARE-EXPERTISET

) MS-Windows -+ AVG-AntiVirus -+ Adobe-AcrobatT
- MS-Word -+ MS-Excel —+ MS-PowerpointT
) MS-Project -+ Quickbooks -+ Basics-PayrollT
" Q1-Macros -+ Inventory-Mngmt -+ PowerPivot'

[] You can adjust the tabs at any time. Select the text. Click on a tab stop on the
ruler and slide the tab stop along the bottom of the ruler

IMPORTANT: Keep the cursor on the bottom edge of the ruler or you may
delete the tab..

[] Move the tab stopsto1% ”and3% “.

'E"'I"'l"L"'Z"'I"'J'LI"'4"'I"

AREAS-OF-SOFTWARE-EXPERTISET

MS-Windows - AVG-AntiVirus - Adobe-Acrobatf
MS-Word - MS-Excel -+ MS-Powerpointf
MS-Project —+  Quickbooks -+ Basics-Payrollf
Ql-Macros  —+ Inventory-Mngmt -+  PowerPivotT

TIP: To turn off Show Formatting symbols, click the command
in the Home Tab.

TIP: To remove a tab stop, click, hold, and drag it off of the ruler.

1 Email your assignment to your instructor.
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